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1. The Rack in Detail 

 

The Rack Control Strip 

At the top of each Rack there is a strip which controls the Rack and assigns it to processing 

groups. The control strip has the following windows and buttons: 

 

In/Out  Disables the Rack’s plugins and passes the signal directly from Rack 

input to Rack output. Typically used for “before and after” comparison or 

to bypass processing. 

Mute Mutes the Rack but does not remove it from CPU processing. Muting is 

performed on the Rack’s input to allow reverb tails and delay taps to fade 

gracefully. 

Rack Name  Displays the Rack’s name. Double-click to rename. 

Group Name  

 

Refers to a latency alignment group to which the Rack may have been 

assigned. Use the pull-down menu to assign the Rack to another latency 

group. 
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Selecting Racks and Using Keystroke Commands 

Using a mouse, right-click on the top part of a selected Rack. You will see a pull-down menu 

that offers several functions: 

 

Active(On) The Rack is always active. 

Bypass Disables the Rack’s plugin processing and passes the signal 

from the Rack input to the Rack output. 

Mute Mutes the entire Rack but does not remove plugins from CPU. 

Global Paste Rack Copies the Rack’s parameters from the recalled Snapshot and 

pastes them into the selected Snapshots when “Global Paste” 

is selected in the Snapshot Pane. (For example, if your singer 

has a cold and you need to EQ the vocals differently, Global 

Paste allows you to change specific settings, then embed these 

parameter changes into all of the Snapshots you’ve made, 

rather than having to adjust each Snapshot separately.)  

The Global Paste function is discussed in detail in the 

“Snapshots” section of this manual. 

Recall Safe Places the selected Rack or plugin into a “safe” mode which 

protects it from Snapshot recalls. "Recalled Safe" racks or 

plugins are unaffected by all Snapshot recalls, even if a 

Snapshot has parameters that "should" be changed on 

Snapshot recall.  
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Assign the Rack to a latency 
alignment group 

Presents a list of available latency alignment groups from 

which you can assign a latency group/s to a rack/s. 

Latency Displays the Rack’s overall latency (accumulated inserted 

plugin latencies). 

CPU Consumption Displays the Rack’s CPU consumption (usage) on the 

SoundGrid Server and the core it runs on. 

 

Input and Output Sections 

 

To the right of the Input Rail is the Input Audio Fader, with a range of ±18 dB.  

On the far right side of each Rack are the Output Rail and the Output Audio Fader. Rack audio 

input and output levels are stored within Snapshots. 

The first step in building a MultiRack processing setup is to add empty Racks. Click on the Rack 

space that says Click to Add Rack, or select Add Racks from the Window menu. 
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This opens a dialog box that enables you to specify the number of Racks you want to add, as 

well as what type of Racks (Mono, Stereo, Mono-to-Stereo, or Surround). Don’t worry about 

making the wrong choice; you can always change this setting later. 

  

 

Choose the input and output channel types and the number of these Racks you wish to add. To 

add additional Racks with a different combination of input and output types, click on the plus (+) 

sign. This creates a new row from which to select other channel types. Use the minus (-) button 

to remove a selection line from the “Add Racks” dialog. This does not affect existing Racks. 

Click OK to complete the process. 

You can also automatically route inputs and outputs as you add them. Selecting “AutoRoute 

Racks” when adding new Racks takes into account the existing Rack routing and then patches 

new Racks accordingly. If, for example, the previous Rack’s input is 7 and the output is 9, new 

Racks will start with Input 10 and Output 10. Routing of subsequent new Racks will increment 

from there. This provides a means of adding and routing Racks at the same time. 

You may also route Rack input and output manually. Define the audio input and output channels 

of each Rack by clicking on the left (input) and right (output) side rails of the interface. The 

Audio I/O pull-down menu will open. Channels you have routed to MultiRack in the Connection 

window will appear in the Input I/O menu. Channels you have routed from MultiRack will appear 

in the Output I/O menu per the I/O device you are using and the connections you have made in 

the Connections window. Set the channel(s) for both input (left side rail) and output (right side 

rail) for each of the Racks you’ve created. 
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The Input Rail is located at the far left of a Rack. Here you choose an input source. 
  

  

Input     Output 

Each Rack can be connected to input and output channels using the drop-down menus. Invalid 

Input or Output configurations are grayed out. 

When a Rack output is set to “None” and the input changes from one channel format to another, 

the output will change its channel format to match the input. An input set to “None” will behave 

in the same manner.  

Or consider a Rack with input and output whose channel formats are compatible. If the input 

changes to a format that is incompatible with the output, then the output will attempt to change 

to a channel format that is compatible with that of the input. Failing that, it will default to “None.” 

A single input channel can be connected to one Rack only, so Racks cannot share the same 

input(s).1 A physical output channel can be connected to one Rack only. Two or more Racks 

cannot share the same output. 

Use the same menu to set the input/output channels and to switch the channel configuration of 

the Rack. 

  

                                                
1 This maintains a 1:1 relation between an SD channel and a Rack, so that a specific Rack can be called 

from the Solo button. 
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2. Adding Plugins to a Rack 

 

 

 

To add a plugin to a Rack, touch the “plus” (+) sign to the right of the Input Fader. Select a 

plugin from the pull-down menu. An icon representing the plugin will appear on the Rack, along 

with a new “plus” (+) sign that you can touch to add a new plugin to the right of the existing one.  

The signal flow within a Rack is always from left to right.  

While in the Main view (or Rack view), you can always change the plugin sequence within a 

Rack by grabbing a plugin and dragging it to the desired location. Each plugin icon has an "In" 

switch that bypasses the processor without disengaging it from the Rack.  

 

There is also an LED indicator on the icon that shows plugin output state: gray = no signal, 

green = signal, red = clip.  
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3. Rack View: Controlling Your Plugins 

 

Double-touch a plugin's icon to open its interface, and enter MultiRack SoundGrid Rack view.  

     

Here you can adjust each plugin parameter by selecting the parameter on screen and using the 

Touch-n-Turn knob or toggle to set the selected parameter. Some controls on selected plugins 

might appear too small for touch selection—please use DiGiCo's keyboard with mouse for more 

precise operation. If you’re already familiar with Waves plugins, this window will be very easy to 

use. 

At the top of each plugin window is a WaveSystem Toolbar, used to load, save and compare 

processor settings. The layout of the WaveSystem Toolbar may vary from one plugin to 

another. Use this toolbar to save plugin- or Rack-specific presets. 
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There are two quick ways to move from one plugin to another within a Rack: 

1. Use your keyboard’s left and right arrows. This will move you through the list of plugins 

in the Rack, opening each plugin interface as it is selected.  

Note: If a plugin control is selected, the left and right arrows will no longer navigate from 

one plugin to another, but will instead affect the value of the parameter,. 

 

2. Touch another plugin icon. This will move you directly to the new plugin and open its 

window. 
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4. System Toolbar Buttons 

 

 

Setup A (Setup B)  Toggles between two setups, allowing you to compare different settings. 

This facilitates quick A/B comparisons and lets you determine which of two 

settings works best without having to save a preset. An asterisk (*) on the 

button indicates that changes have been made since a preset was loaded.  

A►B; B►A  Copies the current settings to the second setup register. The direction of 

copying is from the currently shown setup to the one not shown.  

Load  Here you load factory presets, user presets, and other preset files. Factory 

presets are permanent elements of the Load popup menu, created by 

Waves. They cannot be changed or deleted. You can turn the current 

settings of the plugin you’re using into a user preset by clicking the Save 

button. User presets can be changed and deleted, and the preset files you 

save through the toolbar will appear as Load menu presets until you close 

the preset file or close the plugin. Some plugins have a very large library of 

presets, too large to display on the main pull-down menu. To load these 

library files or load presets from external files, select “Open Preset File.” 

Waves preset files are saved with an .XPS extension  

Save  Save your plugin presets here. You can save the current parameters as a 

user preset in the Preset menu, or create a new file. If you choose to save 

the preset as a new file—outside the plugin’s Preset menu—WaveSystem 

will ask you where you want to put it.  

 Clicking on the Waves logo will bring up the “About This Plugin” page, 

providing information about the plugin. 
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5. Inserting a Rack into an SD Channel 

Choose a port from the Insert drop-down menu. If sockets aren’t assigned as the Rack input, 

they will be named <Waves #> (for example, “Waves 1”). Once a socket is assigned as the 

Rack input, it is named based on the Rack name and the specific stem (for example, “Rack 2 

L”). 

 

Set routing by selecting a Port:Rack. You can send audio to any port or to multiple ports without 

restriction. The Rack whose name is displayed here is the Rack that receives input from this 

port.  

Below are two examples of how you can use Waves plugins in your session: as an Insert, or 

through an Aux. 

Example 1: Assigning Waves Plugins to a Channel Insert A  

To open the Ch## Outputs dialog you can do one of the following: 

1. Press the console's Screen Assign left or right button, and select the desired channel. 

Tap Insert A to open a sub-menu.  

2. From the sub-menu, tap Insert A on the touchscreen and select a channel in the Ch## 
Outputs routing window. 

Set Routing: 
1. Click on Ins A Send. 

2. Set the Insert On 

3. In the Ch## Insert Send Route window, click send+return. 

4. In the Ports column, choose Waves.  

5. Choose a Signal Group.  

6. Under Signals, choose the desired Waves I/O. 
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Example 2: Setting Rack as Parallel FX 

To use a Rack for parallel FX processing, you must use an Aux channel (mono or stereo). 

Return audio to an Input channel.  

The Aux channel:  

In the example below, we will use Aux01 (mono). 

Open the Aux01 Outputs dialog by doing one of the following: 

1. Open the Master channel view by pressing Screen Assign on the console’s center 

section. Select a Master channel, and then tap Outputs. 
2. Touch Outputs to open the routing panel for the desired Master channel.  

Set Routing: 

1. Click Output. 
2. In the Ports column, choose Waves.  

3. Choose a Signal Group.  

4. Under Signals, choose the desired Waves I/O. 
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The FX Return to an Input Channel 
 
The example below uses Input Channel 12. To open the Ch12 Setup dialog, do one of the 

following: 

1. Open Channel view by pressing the console's Screen Assign left or right button. 

2. Select the desired input channel for the FX Return, and touch Input to open the Ch12 
Setup. 

3. Set Routing: 

a. In the Ch12 Setup window, click on Main Input. 
b. In the Ports column, choose Waves.  

c. Choose a Signal Group.  

d. Under Signals, choose the Waves I/O and select the Aux output as established 

in the previous section. 



 

 15 

     

6. Rack Types: Mono, Stereo, Surround and Up/Down Mix 

Use the MultiRack Add Rack dialog to create and add more Racks. The Rack type is 

determined either by which input and output configurations are selected when the Rack is 

added, or, when I/O settings are changed on each Rack I/O menu, as described above. 

Rack type switching  

To change a Rack type you must change its I/Os. Racks will not switch between types based on 

the SD channel they’re inserted on. 
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7. Setting up a Sidechain 

Sidechains are used by some plugins to modify their behavior, for example, to allow ducking by 

a compressor plugin. Each Rack can be set to receive a sidechain from the MultiRack inputs. A 

stereo Rack can receive a stereo or mono sidechain signal. A mono or mono-to-stereo Rack 

can receive a mono sidechain signal.  

Sidechain List  
The Sidechain Input List is displayed in the same manner as the SD channel: Socket# or 

Socket/SD channel name. The socket name is displayed if a Rack is not routed to the socket. 

Otherwise, the Input list shows socket names as shown in the Audio I/O SD window and on the 

insert buttons. 

 

For example: 

Socket name: socket not routed 
Sidechain list, regardless of how many 
channels are in the sidechain 

Socket#1 is default at Waves 1 1: Waves 1 

Socket#2 is named SD Ch 1 2: Ch 1 

Socket#3 is default at Waves 3 3: Waves 3 

Socket#4 is named SD Ch 2 4: Ch 2 

 

If the MR Rack is mono, then choosing a sidechain channel is straightforward. 

If the MR Rack is multi-channel—stereo, for example—then choosing a sidechain channel 

results in additional consecutive channels being selected. This selection will include as many 

channels as the sidechain is made up of. 

For example, if you select a stereo Rack, “2:Rack1,” then “3: Waves 3” will also be selected. 

Selecting “3: Waves 3”, will also select “4: Rack2”. 

The top section of the Rack features a drop-down menu called Sidechain. Use this menu to 

select the input that will be feeding the sidechain signal to the Rack.  
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1. Insert a plugin with sidechain capabilities. Plugins with sidechain capabilities are marked 

with (sc) after the plugin’s name.  

 

 

2. Right-click on the plugin and select Enable Side Chain from the drop down menu. This 

can also be done by clicking the SC button on the side of the Rack View (see below). 
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3. Sidechain-enabled plugins are marked by a yellow SC button and by another yellow SC 

button on the side of the Rack View (see below). 
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The same device input can be used for a Rack’s input and sidechain simultaneously. You can 

preview your sidechain input by clicking on the speaker button. 
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8. Group Properties: Organization & Latency Alignment 

This window allows you to group several racks together. Racks often have something in 

common, and it may make sense to assign all relevantly similar Racks to a latency group.  

Grouping all of the channels of your brass section, or drums, or audience, then assigning these 

groups a color will help you keep track of your racks in concert situations. Also, each track will 

display the name of the group, further aiding quick visual organization. 

        

 

Plugins may impose a delay (known as “latency”) as a signal passes through them. Often, this is 

not a problem. However, on certain occasions you will want to time-align all of the Racks in a 

group in order to compensate for different processor latencies that may cause phase-related 

problems.   

Use the Latency Group Properties window to create groups of racks and align their latencies. 

Open this window from the pull-down menu located at the top of a rack or from the Window 

menu. 

In the Group Properties window, you can create up to 16 processing groups, each of which 

can contain any number of racks. 
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Create a group by double-clicking on a Group Name cell and typing the name you want to 

assign the group (using the external keyboard). Now, decide how you want to align the 

processors within the group.  

None A group is created, but there is no latency alignment. 

Auto The group is delayed to match the latency of the rack in the group with the greatest 

total latency. 

Manual Manually delay the group by a specific value by entering it in the Latency field. The 

value is displayed in samples, milliseconds, meters or feet, depending on your choice 

in the pull-down window. The minimal value allowed for this setting matches the 

latency of the rack in the group with the greatest total latency. 

Groups are color-coded for easier identification. Color selection is based on placement in the 

list, and is not user-definable.  

At the bottom of the Group Properties page is the Align All section.  

 

Here you can align all groups of racks in order to create a unified timing for all channels. The 

Auto setting will offset all of the groups to match the timing of the group with the greatest 

latency, while Manual will delay all groups by a specific value.  
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Below the Align All section is the “Speed of Sound” setting.  

 

This parameter control, expressed in meters per second, allows you to calibrate MultiRack 

SoundGrid’s latency controls to match measured speed of sound. The speed of sound at sea 

level, at a temperature of 20 degrees Celsius and dry air, is 343 meters per second.  
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9. Snapshot Pane: Automating Your Racks 

Snapshots contain the following parameters: 

1. Rack input and output gain 

2. Rack in/out, mute and on/off states 

3. Current plugin parameters 

Snapshots are contained and saved as part of the Session file and are displayed as a vertical 

playlist. 

Use Snapshots to change the state of racks (Mute/In/Off), levels, and, most importantly, the 

settings for the plugins.  

Technical Note: Snapshots do not change the physical configuration of a session, so you cannot 

use a snapshot to change the audio I/O, the rack order, or the plugins embedded in a rack. 

To open the Snapshot Pane (Fig. A), go to Waves tab > View > Open Snapshot Pane. 

   

Fig. A – MultiRack Snapshot Pane  Fig B – DiGiCo Snapshot Window 
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To save a Snapshot of your existing rack environment, use the console’s Snapshot 
Management window (see Fig. B above). Add Waves to the snapshot’s scope.  

When creating snapshots on the SD snapshot window, the snapshot will automatically be 

created, with the same name, in MultiRack’s Snapshot Pane. 

 

Note that selected snapshots are highlighted, with the currently recalled snapshot’s name 

appearing in boldface with its number highlighted, as shown above. 

At the bottom of the Snapshot Pane, under NOTES, is an area where you can write notes about 

the selected snapshot. 
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Global Paste and Recall Safe Modes 

There are times when you don’t want certain racks or specific plugins to be affected by 

snapshot changes, and there are times when you wish to apply a setting of a plugin or rack 

across several snapshots. 

The Global Paste and Recall Safe are the tools that give you that ability. 

Global Paste 

Global Paste enables you to copy a plugin’s or rack’s parameters into one or more other 

snapshots. This is useful when you’ve set up several racks filled with plugins and you decide to 

change plugins settings across several snapshots.  

1. Recall the snapshot from which you want to copy settings. 

2. Touch the Global Paste “On” button.  

>  

3. Select the target snapshot/s that you want to modify. To select multiple snapshots, 

Ctrl+Click on the desired target snapshots, or Shift+Click to select several contiguous 

snapshots (using a mouse). 

4. In the rack windows, select the plugin or rack to which to copy the selected snapshots to. 

Right-click on the plugin and choose Global Paste Plugin/Rack from the menu and 

touch the “Apply” button. Repeat this for each of the plugins or Racks whose settings 

you want to Global Paste.  

5. Touch the Global Paste button “On” in the snapshot Pane once again to turn this mode 

off and end the process. 
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Recall Safe 

The Recall Safe mode allows you to select the racks and/or plugins that won’t be affected as 

you change snapshots that would normally affect them. The Recall Safe option applies within 

the session (and not to a specific snapshot).  

Turn Recall Safe “On” in the Snapshots Pane  

>  

 

Racks: Select a rack you want to set to Recall Safe. Touch the “Set” button or right-click on the 

selected rack and choose Recall Safe from the pull-down menu. "Recall Safe" racks glow blue: 

 

Plugins: Select the plugin you want to set to Recall Safe. Touch the “Set” button or right-click 

on the selected plugins and choose Recall Safe from the pull-down menu. "Recall Safe" plugins 

glow blue: 
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To remove a rack or plugin from Recall Safe mode, select the respective rack or plugin and 

touch the “Unset” button or de-select Recall Safe from the right click pull-down menu. 

Plugins or racks that are set to Recall Safe can be edited. However, their Recall Safe status can 

be viewed only while in Recall Safe mode. Selecting Recall Safe in the Snapshots menu does 

not activate or de-activate Recall Safe. Rather, it only allows you to see plugins and racks, and 

set them to Recall Safe. When you turn Recall Safe mode off, racks and plugins which have 

been Recall Safe remain so; they just don’t glow blue. 

When a rack is Recall Safe, all the plugins within that rack are affected, i.e. are effectively 

Recall Safe as well. 
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10. Saving in MultiRack SoundGrid 

MultiRack SoundGrid offers four different levels of “Save,” enabling you to quickly and 

confidently store and recall needed Session information. From most specific to most general, 

here are your options for saving information: 

• Per Plugin: Each plugin has its own WaveSystem Toolbar, so you can load and save 

your favorite plugin settings without affecting the rest of the processing environment. Say 

you have a C4 preset that you’d like to use for the bass. Simply load the preset from the 

C4’s WaveSystem Toolbar’s Load menu. Plugin settings can be saved to an external 

USB key and loaded on to another console, given that the same plugins are installed 

and authorized on both consoles. 

• Per Rack: There’s a WaveSystem Toolbar at the top of each rack, so you can load and 

save settings for an entire Rack, independent of the Snapshots. Plugin settings can be 

saved to an external USB key and loaded into another console, given that the same 

plugins are installed and authorized on both consoles. 

• Sessions hold the settings for every plugin and all racks. MultiRack Sessions are saved 

alongside the console’s Session file; both files are named identically and are loaded in 

synchronization when the corresponding console Session file is loaded. 

• Snapshots hold the settings for every plugin and rack. Snapshots are created and 

stored on the console main Snapshot window. 

The chart below illustrates the relationship between functions and snapshots/presets/session 

management within the Waves MultiRack and DiGiCo system:  

 Plugins Racks Snapshots  Session 

Rack routing - - - All racks 

Rack in/out gain - Single rack All racks All racks 

Rack in/out and 
mute state 

- Single rack All racks All racks 

Plugin chains 
and parameters 

Only preset for 
individual plugin 

All plugins in single 
rack 

All plugins All plugins 
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11. Overview Window – Viewing the Status of All Racks 

Once you’ve filled several racks, you’ll want a convenient way to keep track of everything 

happening within your processing environment. To get an overview of your racks, select 

Overview from the View menu. This will reveal the Overview window, where you’ll see a 

condensed view of each rack.  

 

The Overview window tells you if a rack or an individual plugin is functioning, and enables you 

to turn on or off, bypass, or mute a rack. Clipping is also indicated for each rack. 

Use the Overview window when you want to keep an eye on the entire processing setup. Since 

each mini-rack in the Overview window displays clipping information, you can easily watch out 

for over-clipping across your entire setup. 
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13. Show Mode 

 

Show Mode is a “safe mode” used during performances which lets you adjust parameters within 

plugins, without changing the routing, configuration, and other settings that could cause 

problems in a live situation.  

When Show is selected you are locked out from much of the interface. 

To switch between Setup and Show modes, go to Master view > System tab > Security and 

switch between Setup and Live. 

>  

When choosing Setup, MultiRack will switch to Setup mode; when choosing Live, MultiRack will 

switch to Show Mode. 
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14. Automatic Recovery 

Since MultiRack SoundGrid is an application for live shows, it is equipped with an automatic 

recovery mechanism. This means that if MultiRack SoundGrid quits unexpectedly, it will 

automatically relaunch and reopen the same session file it was running when it crashed, with 

the same snapshot that was recalled when the crash occurred (if applicable). While MultiRack 

SoundGrid relaunches itself, streaming and processing audio continues without interruption; 

only user control is lost until MultiRack SoundGrid reloads its Session. 

 

15. Rescan Present Licenses 

 

If you are preparing a setup and routing without licenses (i.e. without a connected USB flash 

drive), the plugins will load in a disabled state. The plugins won’t process audio, but you can still 

assign inserts and FX as well as load plugins and presets.  

To enable disabled plugins: 

• Connect your USB flash drive. 

• Go to Window Menu and select “Rescan Present Licenses.” 

All disabled plugins will be enabled. 

• You can re-enable plugins individually by right-clicking on a disabled plugin and 

choosing the enable option from the menu. 
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16. System Monitor Window 

This Window offers general information to the current state of the SoundGrid system. To get to 

this window, go to the Audio menu and select the System Monitor item, or press CTRL+M. 

 

Open this window from the Window menu. 

This window displays the real-time status info on your network, I/O devices, Servers, and 
Integration controller. 

Redundancy   Displays redundancy status. 

Network Displays network transport load.  
High loads may result in audio drops. 

Processing/Redundant Server 

• Device – Device name 
• Status – Server status (online or offline) 
• CPU Peak and average loads (AVR) – Displays the load on the processing server. High 

loads may result in audio drops. 
I/O Device 1 and 2 (if available) 

• Device – Device name 
• Status – Device status 

Integration – IP of the controller (SD console) and its connectivity status 
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17. Dugan Automixer  

The Dugan Automixer plugin is a MultiRack Native and SoundGrid plugin that’s integrated into 

the MultiRack system. The Dugan Automixer is inserted on the MultiRack’s outputs, post the 

racks. All the racks’ processing occurs prior to the signal reaching the Dugan Automixer plugin. 

For example, if MultiRack is inserted on console channels, turning the Dugan Automixer on will 

insert the Automixer between Rack Outs and Insert Returns, as shown below.  

 

All available Outs are routed through the Dugan Automixer consecutively; Rack Outs routing 

values are thus identical to the Automixer channel number: Rack 1 Mono Out 1 connects to 

Automixer channel 1; Rack 2 Stereo Outs 3-4 connect to Automixer channels 3 and 4. 

When the Dugan Automixer is turned on, all its channels are bypassed by default. 

The Dugan Automixer is installed into the plugins folder: D:\Waves\Plugins V9. 

To open the Dugan Automixer, go to the Waves tab under Advanced > Dugan Automixer, or 

press F9. 

Close the Dugan Automixer by clicking X on top right corner.  

Note that closing the Dugan Automixer window does not stop the Automixer’s processing. It only 

closes its control window. 
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Dugan Channel Count 

The Dugan Automixer window opens 64 processing channels in 8 tabs. 

 

Snapshots – All plugin controls are saved in the snapshots except for Master Pane controls. 

Master pane controls are not saved in Snapshots. 

Recall Safe – The Dugan Automixer can be Recall-Safed as a whole by clicking/pressing the 

Recall Safe button on the plugin’s Master Pane. Alternatively, right-clicking on the top of the 

Dugan Automixer window opens a menu where enabling/disabling Recall Safe is also possible. 

 

When The Dugan Automixer is on, an indicator will appear on the MultiRack window, as shown 

below: 

 

 

License & Session Behavior 

There are three possibilities: 

1. If the Dugan Automixer is not installed. the Waves tab > Advanced menu will show 

Dugan Automixer is Not Installed, and the Automixer’s settings will not be saved in the 

session file. When you load an existing session that contains Dugan Automixer 

processing, the session will load without the Automixer. The Automixer will not be 

removed from the session file. 
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2. If the Dugan Automixer is installed but not activated, the Waves tab > Advanced menu 

will show Dugan Automixer is Not Activated, and the Automixer’s settings will not be 

saved in the session file. When you load an existing session that contains Dugan 

Automixer processing, the session will load with the Automixer disabled. The Automixer 

will not be removed from the session file.  

3. If the Dugan Automixer is installed and activated, its menu item will be shown normally. 

The Automixer will be saved in the session file even if it’s not turned on. 

Use Rescan Licenses to refresh activation for added licenses via the Waves tab > Window > 

Rescan Present Licenses. 

For more information, please refer to the Dugan Automixer manual by clicking on the question 

mark (?) on the plugins GUI.  
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19. Global Tempo (BPM) 

Global Tempo allows all of the tempo-based plugins in the session, such as delays, to sync their  

BPM setting to the same value, which is controlled centrally. If you want a plugin to sync to this global  

tempo setting, set it to “Host. Refer to the plugin manual for specific instructions.  

Tempo can be set on MultiRack’s top bar. 

 

 

To set BPM on the MultiRack interface, tap/click the Tap button, enter the BPM value directly  

into the value field, or scroll the value up or down.  

* TAP button: Tap the button to set global tempo.  

* Tempo LED: The LED flashes at the tempo rate.  

* Tempo display: Displays the BPM value and allows setting it by entering a number. 

  

The BPM setting is saved in the session file as well snapshots. This allows you to set a different BPM 

value in each snapshot. 
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Appendix 

20. MultiRack Menus 

Session View Window Advanced 

Import All Rack Presets 

Export All Rack Presets 

Auto-Route All Racks 

View/Hide Snapshot Pane 

Main View 

Overview  

Rack View  

Add Racks 

Preferences 

SoundGrid Inventory 

SoundGrid Connections 

Latency Group Properties 

System Monitor 

Rescan Present Licenses  

About 

Enable Verbose 

Mode 
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21. MultiRack SoundGrid Keyboard Shortcuts 

If you are using an external keyboard you may want to get familiar with MultiRack’s keyboard 

shortcuts: 

Session Item Definition Keyboard shortcut 

Import all Rack Presets Opens Explorer window,  imports all Rack presets Ctrl+Alt+I 
 

Window Item Definition Keyboard shortcut 

Open Snapshot Pane Opens/closes the Snapshot Pane in MultiRack 

SoundGrid window. 

F7 

SoundGrid Inventory Opens the SoundGrid Inventory Window F2 

SoundGrid Connections Opens the SoundGrid Connections Window F3 

Group Properties Opens the Group Properties window Ctrl+G 

System Monitor Opens the System Monitor window Ctrl+M 

Preferences Opens the Preferences window Ctrl+P 
 

Menu Item Definition Keyboard shortcut 

Main view Mode Opens the main application view (multiple Racks) F4 

Overview Mode Opens the Overview view F5 

Rack view Mode Opens the Rack view F6 
   

Advanced Item Definition Keyboard shortcut 

Enable Verbose mode Creates Log file for troubleshooting.  

Rescan Present 

Licenses 

Starts rescan of licenses on connected USB flash 

drive   

Ctrl + L 

 


